
 

Versi on 3 EN 

© 2004 -200 8 DRail Modelspoor Software  

http://www.drailsoftware. com  

 

Getting  Started  

with   

 

 

 

 

 

 

 

 

  



 

 -  1 -  

Contents  
1 INTRODUCTION  ................................ ................................ ................................ .......  3  

2 SETTING UP  ................................ ................................ ................................ .............  4  
Choosing a measurement system  ................................ ................................ ................................ ..................  4 
Spec ifying a table size  ................................ ................................ ................................ ................................ . 5 
View scale  ................................ ................................ ................................ ................................ ..................  5 

3 TRACK LIBRARIES  ................................ ................................ ................................ ...  6  
Opening a Track Library  ................................ ................................ ................................ ...............................  6 
Browsing a Track Library  ................................ ................................ ................................ ..............................  7 
Closing a Track Library  ................................ ................................ ................................ ................................ . 7 
Key to Track symbols  ................................ ................................ ................................ ................................ ...  8 

4 WORKING WITH TRACK  ................................ ................................ ...........................  9  
Adding Track  ................................ ................................ ................................ ................................ ..............  9 
Moving and connecting Track  ................................ ................................ ................................ ......................  10  
Disconnecting Track  ................................ ................................ ................................ ................................ ...  11  

5 FLEX TRACK  ................................ ................................ ................................ ...........  12  
Curves and Straights from Flex  ................................ ................................ ................................ ...................  13  

6 TURNTABLES  ................................ ................................ ................................ .........  14  

7 SELECTING TRACK  ................................ ................................ ................................ .  15  

8 INTRODUCING THE PO PUP MENU  ................................ ................................ ..........  16  

9 PI ECES, STRETCHES AND SECTIONS  ................................ ................................ ......  17  

10 WORKING WITH SECT IONS  ................................ ................................ .................  18  

11 WORKING WITH HEIG HT  ................................ ................................ .....................  20  
Displaying heights  ................................ ................................ ................................ ................................ .....  20  
Specifying hei ghts  ................................ ................................ ................................ ................................ .....  21  
Specifying a level  ................................ ................................ ................................ ................................ ......  22  

12 THE STATUS BAR  ................................ ................................ ................................ .  23  

13 MORE THAN JUST TR ACK  ................................ ................................ .....................  24  
Adding F eatures  ................................ ................................ ................................ ................................ ........  25  
Manipulating Features  ................................ ................................ ................................ ................................  26  
Adding Text  ................................ ................................ ................................ ................................ ..............  27  
Marking Track as hidden  ................................ ................................ ................................ ............................  27  

14 FINIS HING UP  ................................ ................................ ................................ .....  28  
Saving your work  ................................ ................................ ................................ ................................ ......  28  
Print preview  ................................ ................................ ................................ ................................ ............  28  
Printing your design  ................................ ................................ ................................ ................................ ...  28  
Generating p ictures  ................................ ................................ ................................ ................................ ...  29  
Generating a list of materials  ................................ ................................ ................................ ......................  30  
Generating a list of Sections  ................................ ................................ ................................ .......................  31  

15  MENUS  ................................ ................................ ................................ .................  32  
The Popup Menu ................................ ................................ ................................ ................................ ........  32  

TRACK ................................ ................................ ................................ ................................ ...................  32  
CONNECTION POINTS AND  ENDPOINTS  ................................ ................................ ................................ .............  34  
WORKSPACE ................................ ................................ ................................ ................................ ...........  35  
TEXT ................................ ................................ ................................ ................................ ....................  35  
FEATURES (LINES / SURFACES)  ................................ ................................ ................................ .......................  36  

The AnyRail Options window  ................................ ................................ ................................ .......................  38  
VIEW TAB  ................................ ................................ ................................ ................................ ...............  38  
DRAWING TAB  ................................ ................................ ................................ ................................ .........  39  
BEHAVIOR TAB  ................................ ................................ ................................ ................................ .........  40  
TABLE TAB  ................................ ................................ ................................ ................................ ..............  41  
TOLERANCES TAB ................................ ................................ ................................ ................................ ......  42  
FLEX TAB ................................ ................................ ................................ ................................ ...............  43  

16 REGISTRATION  ................................ ................................ ................................ ....  44  

 



 

 -  2 -  

 



 

 -  3 -  

1  Introduction  
We've designed AnyRail Ê to be as straightforward as possible. You can start 

experimenting with layouts as soon as you've installed the software.  However, 
itôs probably a good idea to read through this Getting Started guide. 

This guide is formatted for single -sided printing with or without color.  
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2  Setting up  
The Options window enables you to set up AnyRail  to suit your way of working. 

Thereôs a full description starting on page 38 . However, here are two of the 
important features.  

 Choosing a measurement system  
By de fault, all measurements are metric. However, you can change this .  

To specify  a measurement  system  

1)  From the Tools menu, select Options . 
The Options window opens.  

2)  Open the Behavior tab :  

 
 

3)  Select a measurement system and click OK  
If you select fractional units, AnyRail  shows all measurements using 

fractions, e.g. 20 ¾.  
If you select decimal units, the same value appears as 20.75.  

AnyRail  accepts measurements in both formats, and rounds frac tions to the 
nearest 1/32 of an inch.  
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 Specifying a table size  
Naturally enough, AnyRail  thinks of your workspace   as a table . 

To specify  a table s ize  

1)  From the Tools menu, select Options.  
The Options window opens.  

2)  Open the Table tab:  

 
 

3)  Enter a Width  and Depth .  
4)  Click OK .  

 

 View scale  
To zoom in or zoom out  

*)  Open the View menu, and click the Scale item.  

*)  Select a view scale. 1:1 represents actual size.  

 

TIP : For fast zoom, press CTRL and use the  mouse wheel  
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3  Track L ibraries  
The first thing you need is some track!  

AnyRail  keeps track in libraries, and has one for all the well -known 
manufacturers, including Atlas, Märklin, Roco, Peco, and many others. Each 

piece of track matches the original as c losely as possible -  some of them were 
even designed using the manufacturerôs original CAD files.  

 Opening a Track L ibrary  
To open a T rack L ibrary  

*)  Open the  Libraries menu and select a library.  

The Library opens in the top of the screen, but you can drag it if required . 

 

You can have as many libraries o pen as you want. Don't worry, AnyRail  won't 

link incompatible track pieces ï unless you tell it to ( see ñThe AnyRail  Options 
window ò on page 38 ).  

Libraries for 
most major 

manufacturers  

 

A library  full of 

track sections  
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 Browsing a Track L ibrary  
The status bar at the bottom of the screen shows d etailed  information about 
the track.  

 

 Closing a Track Library  
To c lose a T rack L ibrary  

*)  Open the Libraries menu and click the tick to deselect it.  

The library vanishes from your screen.  

 

TIP : To open any menu using the keyboard, press ALT and whichever letter is underlined in 

the menu name . 

 

 

 

* * *  

 

 

(For what all the sym bols mean, see the next page.)  

Hover mouse over 

the track to see the 

tooltip.  

Full information appears 

in the status baré 
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 Key to Track symbols  
Hereôs the key to the track symbols:  

 
Straight  

 

Feeder: Wire the tracks 

here . 

 

Curve  
 

Separator: Isolated 

tracks  

 
Regular Turnout  

 

Curved turnout .  

 
Catch: Turnout to 

make engines derail 

from one direction (as 

a safety precaution) . 

 
Rerailer: Puts the wheels 

back on track  

 
Y-Turnout   Circuit: (o nly for model 

railways )  Generates a 

pulse when passed, 

generally direction 

sensitive.  

 

Three -way Turnout   Buffer: End of the line  

 

Crossing  
 

Uncoupler: uncouples 

rolling stock.  

 

Double Slipswitch  

 

Turntable  

 

Single Slipswitch  

 Flex  Track : Easily cut and bent as required.  

*Other common words for turnout  are ñswitchò, ñpointò and ñjunctionò. 


